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1 Introduccién

En este manual se describe la funcionalidad de la aplicacién KeyTool IUIl version 2.4.

2 Conceptos basicos

KeyTool Ul es una aplicacién dotada de un interfaz grafico de uso muy sencillo, que pretende ayudar en
la realizacion de tareas criptograficas enmarcadas en el entorno de las aplicaciones Java.

El JDK de Sun, incluye algunas herramientas de manejo de claves y del almacén de certificados (keytool,
jarsigner), pero su ejecucion es desde linea de comandos, no se incluyen herramientas visuales que faciliten el
trabajo con certificados. KeyTool IUl pretende dar al menos la misma funcionalidad que las herramientas de Sun
pero con un interfaz grafico muy sencillo. Ademas proporciona otra funcionalidad como la de cifrado de ficheros

Con KeyTool Ul se podra crear un nuevo almacén de claves (KeyStore), importar en él certificados,
firmar ficheros con dichos certificados, etc.

En el momento de escribir este documento la Ultima version disponible de la aplicacion es la 2.4.
Puede encontrarse informacion adicional en inglés sobre el producto, en la pagina web:

http://yellowcatl.free.fr/index ktl.html

o en francés, en:

http://ragingcat.developpez.com/java/outils/keytool/ui/

3 Integracién con la implementacion Java

La aplicacion KeyTool IUIl es una herramienta desarrollada en Java y como tal utiliza por defecto el
almacén de certificados que viene con la implementacion Java con la que se arranca la aplicacion. Puede verse
accediendo al menu: “Help > About - KeyTool IUI...”, en la pestafia ‘Advanced’ se indica el almacén de
certificados que utiliza el sistema por defecto:
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& About KeyTool 1UI x|
General [ Advanced |
Launcher:
Eclipse plugin

MetBeans IDE module
Java Wieh Start
« standalone application

Properties:

Application's cache dir. [C:\Documents and Settingsladminirocp

User name: [admin

Certificate stores:

Systern-level root CA |CAProgramastdavay2EEsdkjdiijrallimsecuribicacernts

3.1 Conceptos basicos de Criptografia y Java

En Java existen dos APIs utilizadas fundamentalmente para temas criptograficos, son: JCE (Java
Criptography Extension) y JSSE (Java Security Socket Layer).

JCE es un API que da soporte para la realizacion de servicios criptograficos como: implementacion de
algoritmos de cifrado (RSA, DSA, AES, Triple DES, SHA, PKCS#5, etc.), cifrado de textos (simétrico, asimétrico,
de bloque, etc...), firmas digitales, generacion de claves y certificados, etc.

JSSE se utiliza fundamentalmente para comunicaciones seguras, dando soporte a protocolos como SSL,
TLS, Kerberos (utilizando GSS-API). Ofrece una completa implementacion de HTTPS sobre TLS y SSL.

Ambas APIs utilizan los almacenes de claves y certificados (Keystores), que son ficheros que almacenan
de forma segura los certificados de las entidades certificadores, los pares de clave publica y privada de un
usuario y cualquier otra clave privada utilizada para cifrar un texto.

El almacén que utiliza Java por defecto es el que se encuentra en el directorio lib\security\ de la
implementacién JRE utilizada, y se llama cacerts, pero puede cambiarse, bien en el arranque de la aplicacion,
bien por programa.

Cuando en el presente manual se hace referencia a una clave privada, se esta haciendo referencia al

conjunto de clave privada — clave publica utilizado en el cifrado asimétrico. Cuando se hace referencia a una
clave secreta, se esta haciendo referencia a la utilizada en el cifrado simétrico.
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4  Visualizacion de de certificados y claves

Con la aplicacién KeyTool IUI se pueden ver todos los certificados de las autoridades certificadoras (CAS)
y claves (publica y privada) que incluya un almacén.

4.1 Formatos admitidos para certificados y claves

Los formatos que admite la aplicacién para almacén de claves y certificados son:

Extension
Formato Nombre del Fichero
IKS Java Keystore o Tipo de formato ideado Jjks
inicialmente para el Java de Sun Ks
JCEKS Java Cryptography Extension Definido en el API JCE jce
Keystore
Public Key Cryptography p12
PKCS12 Standards #12 .pfx
Definido por el grupo
BKS Bouncycastle Keystore BouncyCastle .bks
UBER Bouncycastle UBER Keystore Version mas segura definida por .ubr
el grupo BouncyCastle

También pueden visualizarse los certificados guardados en ficheros. Los formatos de fichero aceptados
por la aplicacion son:

Formato Extension
del Fichero
DER Codificacion DER: Definido en el estandar X.690 de .crt
Distinguished Encoding Rules ITU-T cer
. Derivado de la sintaxis definida
CMS Cryptographic Message Syntax en PKCS#7 .p7c
e ., o También llamada: “printable
PEM Codificacion PEM: Erlvac_:y- PKCS#7”, por generar un fichero .pem
Enhanced Electronic Malil ASCII
. Estandar para la solicitud de
PKCS10 Public Key Cryptography certificacion de una clave -p10
Standards #10 e .csr
publica a una CA.
. Utilizado en las respuestas de
PKCS7 g?;)r:gal:c?g gyptography las CAs a una solicitud de .p7b
certificacién (PKCS#10).
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4.2  Visualizacion de certificados y claves enun al  macén

Para ver los certificados y claves en un almacén, acceder al menu: “View > File > Keystore” y
seleccionar la opcion deseada en funcion del formato del almacén.

& xeyTool TUI

File | Wiew | Tools Help

Selecttask ¥ | B0 [

File b | Keystare k| 8 JKS kevstore L
Certificate ¥| 8 JCEKS keystore ..
O EC M PKCE12 keystore .. -
MBS keystore €
D Secret key * —
o [ Archive files LEER keystore ...
[ Directary Systern-leval root CA certificate store
s I LT T D Y R N S B T T

&

Se puede acceder también desde el botdn de la barra de herramientas:

Se mostrara un cuadro de didlogo para seleccionar el almacén:

& KeyTool IUI - select x|
Buscar en: |ﬁ FruehaskeyTool |V| E

D EuroHelpkS.jce

Mombre de archiva; |EuroHeIpKS.jce |

Archivos de fipo: ‘JCEKS keystores (jre) ‘v|

select H Cancelar |

Aparecerd la siguiente ventana, con todos los certificados y claves que contiene el almacén.
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Private Key (keypair) & Trusted Certificate Entries:

Alias Entry | Valid Date ? | Selt-Signed ? | Trusted C.A 7 | Key Size | Cer Type | Cert Sig. Algo. Madified Date
hhvacert - - 1023 bits  [X.509 SHATwithRSA 16-jul-2008
eurchelpcert ] v - 1024 bits  [X.509 WD SwithRSA 148-jul-2008
eurohelpclave? & Vi < - 2048 bits  [H.509 SHATwithRSA 148-jul-2008
verisigneert Vi Vi < 2048 hits  [X.509 SHATwithRSA 16-jul-2003

Secret Key (shared key) Entries:
Alias [ Entry Modified Date
eurohelpelave3 | & |15-jul-2008

4.2.1. Visualizacién del detalle de un certificado 0 clave

Pinchando con el botén derecho del raton sobre una entrada (certificado o clave), aparecera un menu
contextual con el que se puede obtener mas informacién sobre dicha entrada.

Private Key (keypair) & Trusted Certificate En

Alias Entry | Yalid Date 7
bhvacert v
eurahelpcert ¥
eurohelpclavel B o
varisigncert £ |

Wiew certificate ..

Se muestra en modo texto los datos del certificado o clave.
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A& KeyTool IUI - view X.509 certificate |
Chner=
Ch=VeriSign Class 3 Public Primary Cerdification Authaority - G3, OU="{c) 1999 VeriSign, Inc. - For authorized u
|ssuer=
CH=YeriSign Class 3 Public Primary Certification Authority - G3, OU="(c) 1998 VariSign, Inc. - For authorized u
Wersion=1

Serial Mumher=9BYENG49A33ERZBSDSEEQN48 71 29EF &7
Yalid From=viernes 1 de octubre de 1999 2:00
Walid Until=jueves 17 de julio de 2036 1:59
Signature Algorithm=3HATwith R 54
Fingerprints=
mMO5  COERBEAT.CT.C4CETISERTID:4F 47 44:61:92:049
SHAT: 12200004553 4B:69:97.COE2: DS C3AYELX S5 TEED9BACCE
Key Usage= none
Extended kKey Lsage= none

q| Il [ »

CLOSE

4.3 Visualizacion del almacén por defecto de laimp  lementacién Java

En el almacén de certificados que viene por defecto con el JRE de Java (cacerts), se incluyen varias CAs
en las que se confia. Si se desea ver cuales son, la aplicacion KeyTool IUI facilita el proceso, ya que dispone de
un menu de acceso directo a dicho almacén (ver la siguiente imagen).

& KeyTool IUI

File | Miew | Tools Help

Selecttask ¥ | [B fun

File F | Eeystore P 8 ks keystore -
B S Certificate »| 8 JCEKS keystore ...
— 8 PHCS12 keystare =
D ULl 8 EKS keystore . re
y- il Create 8 UBER keystore .. T
D keystare
¢ [ Keystore's entry Systerm-level root CA cedificate store ..
A T Dt Leeas waith waee W1 enot | | fil |
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{_‘, KeyTool IUI - view JKS keystore

@

Private Key (keypair) & Trusted Certificate Entries:

Alias Entry | Walid Date ? | SeltSigned ? | Trusted CA. 7| Key Size | Cert Type | Cer. Sig. Algo. Modified Date
addirustclassica (= v v v 2048 pits  [}.509 SHATwIthREA  |[02-may-2006 a
addirustexternalca (= v v v 2048 bits  [}.509 SHATwiIthREA  |[02-may-2006 1
addtrustgualifiedea = 7 o 7 2048 hits X509 SHATwIthRSA  |[02-maw-2006 T
aolrootcal v v v 2048 hits  [¥.509 SHATwIthRSA  [17-ene-2008
haltimarecodesignin... | B v v v 2048 hits  [¥.509 SHATwIthRSA  [10-mayw-2002
haltimorecyhertrustea | & v v v 2048 hits  [}(A09 SHATwithRSA  [10-may-2002
bhvacertchain El v - - 1023 bits  [X.504 SHATwithRSA 16-jul-2008
comodoaaaca = v v v 2048 hits  [}.A03 SHATwithREA  |02-may-2006
digicertassuredidroot..| [E] v v v 2048 hits  [}.A03 SHATwithREA  |07-ene-2008
digicertalobalrootca =] v v v 2048 bits  [}.500 SHATwithRSA  |07-ene-2008
digicerthighassuranc... | [=] v v v 2048 bits  [}.509 SHATwithRSA  |07-ene-2008 —
ontrctINAO~g [0 A2 kit ANQ CHAwWithP S N ona- 2002 il
Secret Key (shared key) Entries:

Alias Entry hodifled Date

4.4  Visualizacién de certificados almacenados en fi chero

La aplicacion dispone también de un menu para permitir la visualizacién de certificados almacenados en
ficheros. Para ello, acceder al menu: “View - File - Certificate” y seleccionar la opcion deseada en funcién del

formato del fichero.

& ¥eyTool IUI

File Hiew|IDDI5 Help

Selecttask k
File k| keystore F

£S5 & | Certificate )

DER ¥.509 (hinard cedificate ..

L |

D Welcorme

PRCERT X509 (hinand cerdificate ..
FEM *.509 {asciiy cerdificate ..

I

o ] Create

FRCS#10 (asci) C3R ..

D kevstare

Se mostrara la ventana para seleccionar el fichero:
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Buscar en:

oo
o-0-

] PruebaskeyTaoal -

[} bbvaCertpTh

[ certificateFile.pTh
[ entidadayto.p7h
[ eurohelpeert.p?h
|j| signatureFile.p7h

Mombre de archivo: |en1idadﬁ3-1|:u.p.‘r‘h

Archivos de tipo: |F'I<CS#T cert. (pThl

|v|

zelect ‘ | Cancelar |

Una vez seleccionado el fichero con el certificado o cadena de certificados, se muestra en modo texto la

informacion:

& xeyTool IUI - view X.509 certificates chain

mumber of cerificates in cedificates chain=3

--—- BEGIM x.509 CERTIFICATE #1/3---
Chiyhner=

lssuer=

Wergion=3

Serial Mumber=2CFCEFEE0001 00000091
Yalid From=jueves 20 de julio de 2006 12:43
Walid Until=rmigrcoles 9 de julio de 2008 12:43
Signature Algarithm=3HATwithRSA
Fingerprints=

digitalSignature
.honRepudation
. dataEncipherment

Cadoecdoed Lfmne | e seim— ot critic =l

EMAILADDRESS=sloras@aragon.es, CH=ENTIDAD AYUNTAMIENTO - CIF 8765432

CH=CA-1 UCGA L=Zaragoza, ST=Zaragoza, OlU=Unidad de Cedificacion, O=Gohiar

mMO5:  1A4B0845A1T9B:02.FB:.07.95.66:52.E5:86:ES.FD

SHAT: TCRESZAL4DFEFRCEIE 490 AF SAB2EEYF.BEBZASFSES
key Usage= not critical

List:

[4]

a I |

L]

CLOSE
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5  Gestidn de los almacenes de certificados y claves

Ademas de visualizar el contenido de los almacenes de certificados, la aplicacion KeyTool Ul permite
desde otra opcion de mend, gestionarlos, es decir, cambiar la clave de acceso al almacén, ver la informacién de
cada entrada, borrar una entrada, renombrarla o copiarla, y en el caso de claves secretas o privadas, es posible
también, cambiar la password de acceso a la misma.

Para ello, acceder al menu: “Tools - Keystore manager” y seleccionar la opcién deseada en funcion del
formato del almacén.

B xeyTool IUI

File Wiew Innls|ﬂelp

& o] keystare manager k #hy JKS kevstore ..
T T 77 [ €5 JCEKS keystore .. B
5 & %, PKCS12 keystore ...
—— &%, BKS keystore -
DWeIcDme ¢, UBER kewstore €
9 ] Create
D Keystore Systerm-level root A cedificate store .
- Tl

Se puede acceder también mediante el botdén de la barra de herramientas:

Se mostrara un cuadro de dialogo para seleccionar el almacén:

M KeyTool IUI - select x

Buscar en: ‘ﬁ PruebaskeyToal ‘V‘
[ EuroHelpks jce

Nombre de archivo: |EuroHe|pKS.jce |

Archivos detips:  |JOEKS keystores (ice) |~

| select || Cancelar |

Como en este caso se puede modificar el contenido del almacén, la aplicacién pide la clave de acceso al
almacén:

KeyTool IUI - get password for ﬂ

Enter password: | |

| o || CANCEL |
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k|
Private Key (keypair) & Trusted Certificate Entries:

Alias Entry | Walid Date ? | SeltSigned ? | Trusted CA 7| KeySize | Cert Type | Cer. Sig. Algo. Modified Date
bbvacert - - 1023 hits  [{.508 SHATwithRSA 16-jul-2008
eurohelpcert f v - 1024 hits  [{.508 WD &withF SA 148-jul-2008
eurohelpclave2 @ Vi Vi - 2048 hits  [X.409 SHATwithRSA 148-jul-2008
verisioncert Vi Vi Vi 2048 hits  [X.4509 SHATwith REA 16-jul-2008

Secret Key (shared key) Entries:
Alias Entry Madified Date
eurohelpclavel &= 15-jul-2008

En cada entrada, pinchando con el boton derecho del raton, se mostrard un menu contextual, distinto si la

entrada es un certificado o una clave.

Gestion de los certificados de un almacén

El mend contextual que aparece al pinchar sobre un certificado es el siguiente:

Private Key (keypair) & Trusted Certificate Entries:

Alias

Entry

Yalid Date

hbwacert

=1

ra

eurohelpoe
eurohelpely
werisignoert

Wiew cedificate .

Delete trusted certificate entry ..
Fename trusted cedificate alias ..
Copy trusted cedificate entry ..

Permite:

Ver certificado. (View certificate ...). Tal como se ha explicado en el punto 4.2.1
Borrar la entrada seleccionada (Delete trusted certificate entry ...). Pedira confirmacion.

* Cambiar el nombre del alias del certificado.

Crear una copia del certificado. Pedira el nuevo alias para asignarselo a la copia.
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5.2  Gestion de las claves (privadas o secretas) de  un almacén

El menl contextual que aparece al pinchar sobre una clave es el siguiente:
ﬁ KeyTool IUI - ICEKS keystore manager

Q@ ®

Private Key (keypair) & Trusted Certificate Entries:

Alias Entry | Walid Date * | Sel-Signed
bbvacert v _
eurhelpcert_copy g v
eurchelpeert i
eurohelpclave? == £ F B
werisignoert Yiew cedificates chain ...

Delete private key entry ...
Fename private key alias ...
Copy private key entry

Change private key's passward ..

Permite:
e Ver la informacidn del par de claves publica y privada (View certificates chain ...). o de la clave
secreta (View infos ...), en funcién del tipo de clave seleccionada.
- Borrar la entrada seleccionada (Delete private/secret key entry ...). Pedira confirmacion.
« Cambiar el nombre del alias de la clave (Rename private/secret key alias ...).

e Crear una copia de la clave (Copy private/secret key entry ...). Pedira el nuevo alias para
asignarselo a la copia.

e Cambiar la password de acceso a la clave (Change private/secret key’s password ...).

Las claves en un almacén, ya sean privadas o secretas, estan protegidas con una password de acceso.
Para hacer cualquiera de las acciones anteriores (excepto ver informacion) se pedira la password con un cuadro
de didlogo como el siguiente:

KeyTool IUT - get password o ﬂ

Enter password: | |

(0] CAMCEL
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5.3 Gestion del almacén por defecto de la implement  acién Java

La aplicacion KeyTool IUI, al igual que en la opcién de visualizacion, permite gestionar el almacén de
certificados que viene por defecto con el JRE de Java (cacerts). Para ello acceder al menu: “Tools > Keystore
manager - System-level root CA certificate store ...”

& KeyTool TUT

File ‘iew Il:u:uls|ﬂe|p

& ] Kevstore manager b (%5 JKS keystore .
" | &, JCEKS keystare .. B
-} #, PKCS12 keystore .
— %, BKS keystore .. -
[ welcorne &, UBER kevstore . ¢
o [ Create
D Keystare System-level mn.t Cﬁ- Eelrtiﬂcate store .

Se solicitara la password de acceso al almacén, que si no se ha cambiado, deberia ser: “changeit”. A
continuacion se mostrara una ventana con los certificados en los que se confia. Se podra gestionar dichos
certificados de la forma descrita en el apartado 5.1.

5.4 Cambio de la password de acceso al almacén.

Los almacenes de certificados y claves pueden estar protegidos por password de acceso. La aplicacion
KeyTool Ul permite también cambiar dicha password.

Para ello, en la ventana de gestién del almacén, seleccionar el icono: @ . (Ver la siguiente imagen)

_{_‘5 KeyTool IUI - ICEKS keystore manager

@@

UL L I'EE}.| Chande this keystore's passwoard .. fES:

Alias Entry | Yalid Date Y | Self-Si
bhwacert o .
L L e A [*] i

Se mostrara un cuadro de dialogo solicitando la nueva password y la confirmacion, para detectar posibles
equivocaciones al escribir.

KeyTool IUI - create password |

Enter new password: | |

Canfirrm nesy password: | |

(]2 CAMCEL
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En el presente capitulo se describen el resto de funcionalidades que implementa la aplicacion KeyTool

UL

A cada una de las tareas que se describira se podra acceder tanto desde el menu izquierdo de la
aplicacién como desde la barra de menda, a través de la opcion: “View - Select task”.

iew | Tools Help
Selecttask ® Welcome fo Kevtool 1L I Barra de meni

File | GCreate 3

=10l

3
=8 Archive b

-y %

=] Keytonl 1 | 5190 i

: EI Welcome

[ Welcon] Verity »
% [ Greate | Encrypt b
[ key Decrypt b
¥ '? Ké"r Import
Export ¥
RGED
[ Ec
¢ [ Private key, with vers #3 cert.
[ Dsa
[y Rea
O ec
[ secrat key
o= [ Archive files
o= [ Sign file with private key
o= [ Verify signed file
o= [ Encrypt file with keystare's entry
o= [ Decrypt file with keystore's entry
& [ Import
o= 3 Export

Menid Izquierdo

_—

Unicamente se describira el acceso a cada tarea a través del menu izquierdo, por considerar que el

acceso desde la barra de menu se desprende del anterior.

Por otro lado, para todas las tareas cabe sefialar que, de los formularios que se presentan, los campos

con asterisco son obligatorios.

.. ~ . - 0K
Inicialmente, el botén para llevar a cabo la tarea correspondiente aparece deshabilitado QD .

Se habilitara cuando todos los campos obligatorios hayan sido rellenados _ -

6.1 Creacion de un almacén de certificados

17/38



— Eusko i Informatika Elkart
le Sociedad Informatica del Gobierno Vasco

Para crear un nuevo almacén de certificados vacio, ir a la opcién “Create - Keystore” del menu izquierdo
de la aplicacion.

7 [ Kewtoal 1L
|j| Welcome
9 [ Create

[ keystore|

En la parte derecha de la aplicacion se mostrara el siguiente formulario:

Create keystore without any entries

Target:
o JKS
0 JCEKS
* Keystore file: = [ ) PKCE12
0 BkS
1 UBER

keystare password: @

SEE o«

Seleccionar el formato para el almacén entre los disponibles en la aplicacion: JKS, JCEKS, PKCS12, BKS
y UBER (ver més informacion de los formatos aceptados por la aplicacién en el punto titulado: “Formatos
admitidos para certificados y claves” de este mismo manual).

Pinchar en el icono: [ y en la ventana que aparece, seleccionar la ubicacién preferida para el fichero
del almacén e indicar un nombre.
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& KeyTool IUI - Save file i

Buscaren: ‘lj FruehaskeyTool |v‘ E

D EuroHelpks.jce

Mombre de archiva: |vaevStnre.jce |

Archivas de tipo: |JCEKS £jced |v|

Save file H Cancelar |

Puede indicarse también una password de acceso para el almacén de certificados y claves. Se
recomienda que se indique una.

Pulsar el boton “OK” para terminar el proceso. Debera aparecer un mensaje avisando de que la operacion
se ha realizado con éxito.

KeyTool IUI - information x|

@ Successiully created an empty keystore of type JCEKS.

File location:
CiDocuments and SettingstadmimEscritoriclPruehaskeyToolmykeyStore joe

6.2 Creacion de una clave secreta y asignacion aun  almacén

En esta tarea se creara una nueva clave secreta, de uso en el cifrado simétrico, y se incluird en un
almacén previamente definido.

Para crear una nueva clave secreta ir a la opcion “Create - Keystore’s entry > Secret key” del menu
izquierdo de la aplicacion.
o ] Create
|j| keystare
o ] Keystare's entry
o= [ Private key, with ver
o= [ Private key, with ver

[ Becret key]

19/38



— Eusko i Informatika Elkart
le Sociedad Informatica del Gobierno Vasco

En la parte derecha de la aplicacion se mostrara el siguiente formulario:
Create secret key (shared key) entry

Source:
® JCEKS
#* Keystore file: 3 [ ) BKS
1 UEER

Kewstare passward: @

Target:

New Entry - Secret Key:

# Becret key algarithm: Blowfish -

OK

Seleccionar el formato para el almacén entre los disponibles: JCEKS, BKS y UBER. No todos los
formatos de almacén disponibles en la aplicacién permiten incluir en ellos claves secretas, asi que Unicamente
se puede seleccionar entre los formatos que si lo permiten.

y
Pinchar en el icono y en la ventana que aparece, seleccionar el fichero del almacén.

Elegir entre los disponibles un algoritmo de creacién de la clave (Secret key algorithm). Pulsar OK para
terminar el proceso.

Si el almacén tuviera password de acceso, y no se ha indicado una en el campo “Keystore password”
aparecera el siguiente mensaje:
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KeyTool IUI - warning |

A Got 10 Exception, file location:
ChADocuments and SeftingstadminEscritoriotPruebaskeyToolhmykeyStore joe

... Tampered keystore file, or incorrect JCEKS keystore password!

En caso contrario, aparecera una ventana con el contenido del almacén y en la parte inferior un formulario
para rellenar:

Enter new secret key entry's alias: “

Enter new password: [

Canfirm new pagsword: [

| ok || CANGEL |

En él, sefialar un nombre para la clave secreta y una password de acceso. Todos los campos del
formulario son obligatorios (a pesar de no estar indicado con el asterisco), salvo para el caso de almacenes en
formato PKCS12.

Pulsar OK para terminar la operacién o CANCEL para cancelar.
6.3 Creacion de una clave privada y asignaciéon aun  almacén

En esta tarea se creara una clave privada, de uso en el cifrado asimétrico, y se incluira en un almacén
previamente definido.

Para crear un nuevo par ir a la opcion “Create - Keystore's entry” del menu izquierdo de la aplicacion.
Desplegar el nodo en funcién de si se desea crear una par de claves con version 1 del estandar X.509 (Private
key, with vers. #1 cert.) o version 3 (Private key, with vers. #1 cert.). Dentro de dicho nodo, seleccionar el tipo de
algoritmo deseado para generar la clave: DSA (Digital Signature Algorithm), RSA (Rivest, Shamir, Adleman) y
EC (Elliptic Curve).

7 [ Create
|j| Keystore

9 [ Keystare's entry
9 [ Private key, with vers. #1 cert.

[ paa
RGED
[ EC
9 |j|F'rivate ke, with wers, #3 cert.
[ Dsa
[ rea
[y Ec
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En la parte derecha de la aplicacion se mostrara el siguiente formulario:
ﬁ Create RSA private Key entry, with vers. #1 cert =

Source: :
® KS
3 JCEKS
#* Keystare file: = [ O PKES12
(2 BKS
7 UBER

Keystore password: 2

Target:
Private Key:
#* Key size (hits): 2048 |- 1
# Signature algorithm; SHATwithREA -

# Yalidity {days). F & |1o09s

Cert. - X.500 Distinguished Name:

# Commaon {or domain name: GF [
Organizational unit ¥ [
Qrganization; E? [
City or lacality: 4 [
State ar province: 54 [
# Z-letter country code: [ [— LIS (United States) - |

Seleccionar el formato para el almacén entre los disponibles: JKS, JCEKS, PKCS12, BKS y UBER.

Rellenar los campos obligatorios del formulario, de forma similar a como se ha descrito en el punto
anterior. Rellenar los campos opcionales que se desee.

Respecto a las extensiones, campos opcionales al final del formulario (ver imagen siguiente), en la ayuda
de la aplicacidon se muestra qué opciones activar en la creacion del par de claves para diferentes casos de uso.
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Cert. Extension - KeylUsage:

- encipherOnly:

ENABLED?
- CRITICAL?
- digitalSignature:
- nonRepudiation: [ []
- kevEnciphermenf:
- dataEnciphermefit: [#7]
- keyAgreement ||
- keyCertSion: ||
- tRLSian: O

|
)

- decipherOnly:
Cert. Extension - ExtKeyUsage:

ENABLED?
- CRITICAL?
- serverAuth:
- clientAuth:
- codeSigning
- emailProtection:
- ipsecEndSystem:
- ipsecTunnel:
-ipseclser:
- timeStamping:
- DC3PSigning:

- Microsoft Enroliment Infrastructure: smartcardlog
- Microsoft Crypto 2.0 server gated crypta

- Microsoft Crypto 2.0: serialized

- Microsoft Crypto 2.0: EFS crypta

- Microsoft Crypta 2.0: EFS recovery
- Adobe: CDS PKI

- unknown key usage

on:

Oo0ooooooooooooEEOO

EJie

Bl KeyTool IUI - User's Guide o

<€ » &5

Elkart,

Eusko i Informatika
Sociedad Informatica del Gobierno Vasco

=10l %]

]

] User's Guide
D Welcome to KeyTaoal 1]
[ About .
¢ [ Tasks
9 [ Create
D Create empty keystor
D Create secret key ent
D Create DSA private ke
D Create RSA private ke
[ Create EC private ke £
[ [ereate DA private ke
D Create RSA private ke
D Create EC private ke
o= [ Archive files
o [ Signfile
o= [ Verify signed file
o [ Encrypt file
o= [ Decryptfile
o= [ Impart
o= [ Export
o= [ Supported farmats

About "KeyUsage' Certificate Extension

Exemple of use:

Top lewel CA:
critical,
keyCert3ign,
cRL3ign.

230 wekh server, 351 application server:

critical,
digitalSignature,
keyEncipherment.

Chiject-signing SMI, Chiject-zigning partner, People SMI-£

critical,
digitalSignature.

People SMI-ewmployee encryption:

critical,

[»

4] i | ¥ |
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Pulsar OK para crear la clave y comenzar el proceso de asignacién al almacén. Si el formulario se ha
rellenado correctamente, aparecera la ventana con el contenido del almacén y el mismo formulario que en el
punto anterior (claves secretas). Proceder de forma similar.

En este caso, si el almacén es de tipo PKCS12, no sera necesario rellenar la password de acceso a la
clave.

Problema conocido

Existe un problema reconocido por el autor de la aplicacion en la creacion de claves con algoritmo DSA,
version 1 o version 3. Para los almacenes de tipo: PKCS12, BKS y UBER, aunque aparezca como algoritmo de
firma (Signature algorithm) SHA1withDSA, la clave se estard almacenando como DSA.

6.4 Creacion del jar de un directorio

En esta tarea se creara un fichero .jar con el contenido de un directorio dado.

Para crear un jar con el contenido de un directorio ir a la opcion “Archive files = Directory” del men(
izquierdo de la aplicacion.

7 [ Keytaal 1L
|j| YWelcome
o= ] Create
7 [ Archive files

|j| Directory

En la parte derecha de la aplicacion se mostrara el siguiente formulario:
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Archive directory in JAR format

Source:
# Directony En}-" [
Target:
# Unsigned JAR file: [ < JAR

OK

=

Seleccionar el directorio cuyo contenido se quiere empaquetar en un jar.
Seleccionar el directorio y el nombre del fichero .jar que se creara.

Pulsar OK para terminar la operacion.
6.5 Firma digital de documentos

Se describira en este punto la funcionalidad que ofrece la aplicacion KeyTool Ul para firmar documentos.

Permite firma en modo ‘detached’ cualquier documento, o en modo ‘embedded’ ficheros XML o jar. La
diferencia entre ambos métodos de cifrado es que en modo ‘detached’ el fichero de firma generado no incluye
los datos firmados, sin embargo en el modo ‘embedded’ si.

Para firmar un documento, ir a la opcion “Sign file with private key” del menu izquierdo de la aplicacién y
seleccionar el método de firma deseado.
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&[] Create

o= [ Archive files

¢ [C\Sian file with private key
7 [ Detached signature

[ cms
[ other

9 [ Embedded signature
[ sl
[ Jar

o= 1 Wiarife sinnad fila

El proceso de firma en todos los casos es el mismo:

1. En el formulario que se mostrara en la parte derecha de la aplicacion, rellenar los campos

obligatorios (marcados con asterisco) y los opcionales que se desee. Pulsar OK para continuar
con el proceso.

2. Aparecera una ventana mostrando el contenido del almacén seleccionado. Se indicaran las

claves que pueden ser utilizadas para firmar con el simbolo —_¥"___|. Seleccionar entre todas
ellas la clave con la que se desea firmar:

eyTool IUI - Sign file with private key and save as other detached signature file 5[
Private Key (keypair) & Trusted Certificate Entries:
Candidate * Alias Entry|Yalid Date ?|Sel-Signed ?|Trusted G.A. 7| Key Size |Cert. Type| Cert Sig. Algo. | Modified Date
- bhvacert - - 1023 hits X508 SHATwithRSA  |16-jul-2008
- eurhelpcer_copy o 1024 hits  [¥.509 M D SwithREA 16-jul-2008
- eurohelpeert o 1024 hits  [X.509 MD SwithREA 18-jul-2008
i eyrohelpclave2 s o7 o - 2048 hits  [X.509 SHATwithRSA  |16-jul-2008
- verigigncert Vi Vi Vi 2048 hits [X.509 SHATwithRSA  |16-jul-2008
Secret Key (shared key) Entries:
Candidate 7 | Alias | Entry | Modified Date
. |eurohelpelave | &= |15-jul-2008
Selected entry's alias: [eumhelpclavez
Enter respective password: [uuu
CANCEL

3. En el formulario inferior indicar la password de acceso de la clave seleccionada.

Al pulsar OK aparecera un mensaje de confirmacién indicando que se ha realizado con éxito la operacion.

6.6 Validacién de la firma digital de un documento
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Se describira en este punto la funcionalidad que ofrece la aplicacion KeyTool IUI para validar documentos
firmados utilizando los métodos descritos en el punto anterior.

Para validar la firma de un documento, ir a la opcion “Verify signed file” del menu izquierdo de la
aplicacion y seleccionar el método con el que se sabe que esta firmado el documento.

L L S YV ILL P L sy

T [ Merify signed file

9 [ Detached signature
[ cms
[ other

9 [ Embedded signature
[ ML
[ Jar

S T M and Film il Lema imdmem s

El proceso de validacion es muy parecido en todos los casos:

1. En el formulario que se mostrara en la parte derecha de la aplicacion, rellenar los campos
obligatorios (marcados con asterisco) y los opcionales que se desee. Pulsar OK para continuar
con el proceso.

2. En el modo ‘Other detached signature’ aparecera una ventana mostrando el contenido del
almacen elegido. Se indicaran los certificados que pueden ser utilizados para validar la firma con

el simbolo " |, Seleccionar el de la persona o entidad que firmé el documento.
L\, KeyTool IUI - Sign file with private key and save as other detached signature file 5[
Private Key (keypair) & Trusted Certificate Entries:
Candidate * Alias Entry|Yalid Date ?|Sel-Signed ?|Trusted G.A. 7| Key Size |Cert. Type| Cert Sig. Algo. | Modified Date
- bhvacert - - 1023 hits X508 SHATwithRSA  |16-jul-2008
- eurhelpcer_copy o 1024 hits  [¥.509 M D SwithREA 16-jul-2008
- eurohelpeert o 1024 hits  [X.509 MD SwithREA 18-jul-2008
i eyrohelpclave2 s o7 o - 2048 hits  [X.509 SHATwithRSA  |16-jul-2008
- verigigncert Vi Vi Vi 2048 hits [X.509 SHATwithRSA  |16-jul-2008
Secret Key (shared key) Entries:
Candidate 7 | Alias | Entry | Modified Date
. |eurohelpelave | &= |15-jul-2008
Selected entry's alias: [eumhelpclavez
Enter respective password: [uuu
CANCEL

En el formulario inferior indicar la password de acceso de la clave seleccionada.

3. Enelmodo ‘JAR embedded signature’ se deberan seleccionar los puntos que se quieren validar
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(apartado ‘target’ del formulario).

Target:

Entries' size:
Entries' date: [
Certs type:
Algos name;
Subject DM [

4. Al pulsar OK aparecera un mensaje de confirmacién indicando que se ha realizado con éxito la
operacion.

En el modo ‘JAR embedded signature’ el mensaje de confirmacion es el devuelto por la aplicacién
jarsigner al invocarla con la opcién —verify.

6.7 Cifrado de documentos utilizando la entrada de un almacén

Se describira en este punto la funcionalidad que ofrece la aplicacion KeyTool IUI para cifrar documentos
utilizando una entrada previamente almacenada en un almacén de certificados y claves.

Para cifrar documentos, ir a la opcion “Encrypt file with keystore’s entry” y seleccionar la opcién deseada
en base al tipo de cifrado requerido.
WL WETIY SIgrien e

¢ |j|EncnrptﬂIe with keystore's entrﬂ
E| lze secret key
B U=ze RSAtrusted cerificate
D =g RSA private key

o= [ Decrypt file with keystare's entry

= Secret key: Utilizado en cifrado simétrico.

» RSA trusted certificate: Utilizado para cifrar documentos con la clave publica de una persona. De este
modo nos aseguramos que Unicamente dicha persona pueda leer el mensaje.

= RSA private key: Utilizado para cifrar un documento con nuestra clave privada. De este modo nos

aseguramos que Unicamente podran leer el mensaje aquellas personas que tengan nuestra clave
publica.

El proceso de cifrado es similar en todos los casos:

1. En el formulario que se mostrara en la parte derecha de la aplicacion, rellenar los campos
obligatorios (marcados con asterisco).

2. En cifrado con clave secreta el algoritmo de cifrado vendra definido por el algoritmo que se indicé
al crear dicha clave, en los otros dos casos se puede seleccionar de una lista dada (campo ‘RSA
Encryption Algorithm’).
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3. Pulsar OK para continuar con el proceso.

4. Aparecera una ventana mostrando el contenido del almacén seleccionado. Se indicaran las

entradas que pueden ser utilizadas para cifrar el documento con el simbolo A
Seleccionar entre todas ellas la clave o el certificado con el que se desea cifrar:

A& KeyTool TUI - Encrypt data file with secret key, save result as file |
Private Key (keypair) & Trusted Certificate Entries:
Candidate * Alias Entry|Valid Date ?|SeltSigned ?(Trusted C.A 7| Key Size |[Cert. Type| Cert. Sig. Algo. | Modified Date
- bhvacert - - 1023 hits %509 SHATwithRESA  [16-jul-2008
ehnocifrado = Vi 2048 hits  [x.504 SHATwithREA  [17-jul-2008
elrhelpcert_copy v 1024 hits X409 MWD SwithRSA 16-jul-2008
eurchelpcert v 1024 hits  [x.503 MDSwithRSA  [15-jul-2008
eurchelpcent2 v v 2048 hits  [¥.503 SHATWIthRSA  [17-jul-2008
eurchelpclawe (G v v 2048 hits X408 SHATwithRSA  |16-jul-2008
eurohelpclaved 2 < v - 2048 hits  |[x.609 SHATwithRSA  [17-jul-2008
warisiancert Vi Vi Vi 2048 hits  [x.509 SHATwithRSA  [16-jul-2008
Secret Key (shared key) Entries:
Candidate ? Alias Entry hodified Date
- surohelpclave3 o= 18-jul-2008
Selected secret key entry's alias: Ieurohelpcla\rea
Enter respective password: In"n|
[ o || canceL |

5. En el formulario inferior indicar la password de acceso de la clave seleccionada.
Al pulsar OK aparecera un mensaje de confirmacion indicando que se ha realizado con éxito la operacion.
Limitaciones

Para el cifrado con clave secreta, los algoritmos de cifrado Hmac (md5, shal, sha256, ...) no funcionan
correctamente.

Para los cifrados RSA, el tamafio de los datos a cifrar no deberia ser mayor (en bytes) de:
(<tamafio de la clave de cifrado>/8) — 11
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6.8 Descifrado de documentos utilizando una clave d e un almacén

Se describira en este punto la funcionalidad que ofrece la aplicacion KeyTool IUl para descifrar
documentos utilizando una clave (privada o secreta) existente en un almacén.

Para descifrar documentos, ir a la opcién “Decrypt file with keystore’s entry” y seleccionar la opcion
deseada en base al tipo de cifrado del documento.
o= |7 Encrypttile with keystore's entry

T |j|Decrg.rptﬂIe with keystare's entrg.f|

D Uze secret key
E‘| l=e RSA private key

o e AT

El proceso es similar en ambos casos:

1.

5.

6.

En el formulario que se mostrara en la parte derecha de la aplicacién, rellenar los campos
obligatorios (marcados con asterisco).

En cifrado con clave privada RSA habra que indicar el algoritmo con el que esta cifrado el
documento, en el caso de clave secreta no es necesario.

Pulsar OK para continuar con el proceso.

Aparecera una ventana mostrando el contenido del almacén seleccionado. Se indicaran las

entradas que pueden ser utilizadas para descifrar el documento con el simbolo A

Seleccionar entre todas ellas la clave con la que se desea descifrar.
En el formulario inferior indicar la password de acceso de la clave seleccionada.

Pulsar OK para terminar la operacién.

En este caso, si todo ha ido correctamente no aparecera mensaje de confirmacién, pero si se indicara un
mensaje de error en el caso de que haya algun problema.

6.9 Importacion de claves y certificados a un almac  én

Se describira en este punto la funcionalidad que ofrece la aplicacion KeyTool IUl para importar claves

secretas, claves privadas y certificados a un almacén previamente definido.

Para importar documentos, ir a la opcién “Import > Keystore's entry” y seleccionar la opciéon deseada en
base al tipo de fichero que deseamos importar.

30/38



— Eusko Jaurlaritzaren Informatika Elkartea
le Sociedad Informatica del Gobierno Vasco

T I_II_P'LP\.rI:"HI.IIILP \"\'II.III\.LPJ'-\JI.UILP-\J LrIII.I:|'
o ] Impart
o ] |Keystare's entry

|j| Secret key

9 7 Private key
[y DER file format
[y PEM file format
|j| Frorm other keystore

2 [ Trusted cedificate
|j| Fegular cetificate
[y Root CA cerificate

D Frivate key's cert. from CA cert. reply

—_— 8

= Secret key: Para importar claves secretas.

Se deberéa conocer ademas de la password de acceso a la clave, el algoritmo de cifrado para el que
se cre6 dicha clave. La aplicacion no puede comprobar si el algoritmo introducido es correcto o no,
asi que debe ser el usuario el que se asegure de ello.

= Private key: Para importar claves privadas.

En este caso, habra que seleccionar el fichero desde el que importar la clave privada y el fichero
desde el que importar el certificado (o cadena de certificados) con la clave publica.

Para importar una clave desde un fichero en formato DER, se debera conocer el algoritmo de cifrado
para el que se cred dicha clave.

= Trusted certificate (Regular certificate): Para importar certificados de confianza.
Se seleccionard el formato del fichero a importar entre los tres posibles: DER, PKCS#7 y PEM.

La aplicacion permite seleccionar si se comprobara que la CA del certificado sea una de las incluidas
en el almacén de autoridades certificadoras de raiz (Root CA certs store).

El procedimiento para importar certificados de confianza de Autoridades Certificadoras raiz (Root CA
certificate), se explicara mas adelante.

El proceso para la importacién de claves y certificados es similar en todos los casos:
1. Rellenar los campos del formulario que se mostrara en la parte derecha de la aplicacion.
2. Pulsar OK para continuar con el proceso.

3. Sise ha seleccionado ‘importar desde otro almacén’ (From other keystore), aparecera una
ventana con el contenido del almacén origen. Se indicaran las entradas que pueden ser utilizadas

para importar con el simbolo ¥ | Seleccionar entre todas ellas la clave gue se desea
importar e indicar su password de acceso en el formulario inferior. Si se ha seleccionado
cualquier otra opcion se pasara directamente al punto 4.

4. Al pulsar OK para continuar con el proceso, aparecera una ventana mostrando el contenido del
almacén seleccionado como destino.

5. Rellenar los campos que aparecen en el formulario inferior, indicando el alias para la clave
importada y la password de acceso a la misma.

6. Pulsar OK para continuar con el proceso. Aparecera un cuadro de dialogo indicando que se ha
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completado con éxito la operacion y preguntando si se desea ver el contenido del almacén.
KeyTool IUI - confirm x|

L] Successfully impaorted private key and certs chain files as private key entry.
Mewy private key entry located in keystore:

CaDocuments and SettingsiadmimEscritoriniPruebaskeyToolmylkeyStore joe

Wiew keystore?

0K || CANGEL |

7. Sise pulsa OK, aparecera de nuevo la ventana con el contenido del almacén, donde podra
comprobarse que se ha importado la clave con éxito.

6.9.1. Importacion al almacén de Autoridades Certif _icadoras Raiz: cacerts

Como se ha comentado en puntos anteriores, la aplicacion KeyTool Ul permite la gestion del almacén de
entidades certificadoras (CAs) de confianza que viene por defecto en la implementacion Java (cacerts). Asi
pues, con respecto a la importacién de certificados, la aplicacion permite importar los certificados de dichas
entidades, para confiar automaticamente en cualquier certificado autorizado por las mismas.

Para ello, ir a la opcion “Import > Keystore’s entry > Root CA certificate”.

Ll PRAL I ¥WILED IOy I e o DLy

o ] Import
9 [ Keystore's entry
|_j Secret key
o= [ Private key
9 [ Trusted cedificate
D Regular cedificate
[ Root CA certificate

D Private key's cert. from CA cert. reply

El proceso es similar al descrito en el punto anterior, la Unica diferencia es que en el campo del almacén
viene seleccionado por defecto el definido por la implementacion Java y no es posible seleccionarlo.

6.9.2. Importacion desde el fichero de respuesta de una CA

Cuando una entidad desea que una CA autorice un certificado suyo, envia una solicitud a una CA raiz,
mediante un mensaje CSR (Certificate Signing Request) firmado por su clave privada. La entidad raiz le

responde con un mensaje que utiliza la sintaxis definida en PKCS#7. La aplicacion KeyTool IUI permite importar
desde el fichero de respuesta de la CA raiz.

Para ello, ir a la opcion “Import = Private key’s cert. from CA cert. reply”.
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7 [ Import
9 [ Keystare's entry
|j| Secret key
o= [ Private key
o= ] Trusted certificate

D |F'rivate key's car. from CA cert. reply
o= 8 Evnint

Los pasos a seguir son los siguientes:

1. En el formulario que se mostrara en la parte derecha de la aplicacion, rellenar los siguientes
datos:

= CA cert. reply file: con el fichero de respuesta a la solicitud CSR.

= Keystore file: con el almacén que contiene la clave privada con la que se firmo la solicitud
CSR.

2. Al pulsar OK para continuar con el proceso, aparecera una ventana con el contenido del almacén
origen. Se indicaran las entradas que pueden ser utilizadas para la importacion, con el simbolo

¥ | Seleccionar entre todas ellas la clave con la gue se firmo la solicitud.
3. Completar el formulario inferior.

4. Pulsar OK para continuar con el proceso.

Aparecera un mensaje indicando que se ha realizado con éxito la operacién y preguntando si se desea
ver el almacén con los cambios efectuados.

KeyTool IUI - confirm x|

L Successfully imported private key and cers chain files as private key entry.
Mew private key entry located in keystore:

CADacuments and SettingstadminEscritoriciPruehaskeyToolmykeyStare joe

Wiewr keystore?

oK || CANGEL |

6.10 Exportacion de claves y certificados a fichero

Se describira en este punto la funcionalidad que ofrece la aplicacion KeyTool IUI para exportar claves y
certificados que estén incluidos en un almacén a un fichero.

Para importar documentos, ir a la opcién “Export - Keystore’s entry” y seleccionar la opcién deseada en
base al tipo de clave o certificado que vamos a exportar.

33/38



— Eusko i Informatika Elkart
le Sociedad Informatica del Gobierno Vasco

=] L
9 [ Export

o ] Keystare's entry

E‘] Secret key
D Frivate key
D Trusted cerificate

9 [ Private key's first cerificate in chain
D Az cedificate signing request file
D Az simple certificate file

= Secret key: Para exportar claves secretas.
= Private key: Para exportar claves privadas.

Se exportara tanto la clave privada como la cadena de certificados de la clave publica, es decir, el

certificado con la clave publica en si y los certificados de las entidades que validan el par clave
privada-clave publica, si los hubiera.

= Trusted certificate (Regular certificate): Para exportar certificados de confianza.

El proceso para la exportaciéon de claves y certificados es similar en los tres casos:

1. Rellenar los campos del formulario que se mostrara en la parte derecha de la aplicacion.
Seleccionar el formato del fichero que contendra la clave y/o certificados. Los formatos que
admite la aplicacion para los ficheros exportados son:

Formato Exte_nsic')n
del Fichero
DER .der Fichero binario
PEM .pem Fichero ascii
PKCS#7 .p7b Fichero binario

2. Pulsar OK para continuar con el proceso.

3. Aparecera una ventana con el contenido del almacén donde se encuentra la clave o certificado a

exportar. Se indicaran las entradas que pueden ser utilizadas para importar con el simbolo

¥ | Seleccionar entre todas ellas la gue se desea importar e indicar la password de

acceso en el formulario inferior para el caso de las claves.

4. Aparecera un cuadro de dialogo indicando que se ha completado con éxito la operacion y
preguntando si se desea ver los datos de la clave o certificado.
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KeyTool IUI - confirm |

Trusted edificate successfully exported.
. cettificate location:
DoProgramasikt2 4 stalkll 24 statthawtecert.cer

Wiould you like to view the result?

0K || GANGEL |

5. Sise pulsa OK, aparecera un cuadro de dialogo donde podran comprobarse los datos de la clave
o certificado exportado.

& KeyTool IUI - view X.509 certificates chain x|

murmber of cedificates in cedificates chain=1

---- BEGIM X509 CERTIFICATE #1511 ----
Chyner=
EmMAILADDRESS=persanal-freemail@thawte com, CH=Thawte Persanal Freemail CA,
Issuer=
EmaILADDRESS=personal-freemail@thawte com, CH=Thawte Personal Freemail CA,
Yerzion=23
Serial Mumher=0
Yalid From=lunes 1 de enero de 1996 1.00
Yalid Until=viernes 1 de enero de 2021 0:59
Signature Algorithm=mMDSwithRSa
Fingerprints=
MO5:  TEF4CIEBEIC0C 350 3ECE TR EF ICAMICDY
SHAT 20099:00:BR:3D:9557:28:14:0C:01:36:22:08:CH 87 A4 EB:00:85
Key lsage= none
Extended Key Lsage= none
--—- EMD ¥ 809 CERTIFICATE #1051 --—-

4] Il | [»

CLOSE

6.10.1. Exportacion del certificado con la clave pi _ blica

Lo que se ha nombrado a lo largo de todo el manual como clave privada, es como ya se ha dicho, la
suma de: la clave privada, el certificado con la clave publica y los certificados de las entidades que validan la
clave. Este punto describe la funcionalidad que ofrece la aplicacién KeyTool IUl para obtener el primer
certificado de la cadena, es decir, el certificado con la clave publica asociada a la clave privada.

Para ello, ir a la opcion “Export = Private key’s first certificate in chain” y seleccionar la opcién deseada:
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7 [ Expart

9 [ Keystare's entry
E| Secret key
E| Frivate key
E| Trusted cedificate

T |j|F*rivate key's first cedificate in chain|
D Az cedificate signing request file
|_j Az simple cerificate file

= As certificate signing request file: Para crear el mensaje CSR (Certificate Signing Request)
comentado en el punto 6.9.2.

= As simple certificate file: Para exportar el certificado con la clave publica asociada a una clave
privada.

El proceso es similar al descrito en el punto anterior, por lo que no se describira.
7  Acceso a la ayuda de la aplicacion

El autor de la aplicacion KeyTool IUl ofrece una ayuda muy simple, pero en la que muestra informacién
relevante en muchos casos, como son limitaciones a las funcionalidades que se ofrecen (han sido descritas
todas en este manual) y casos de uso en la creacion de certificados. Por ello, se considera importante el
conocer como se accede a la ayuda de la aplicacion.

Para acceder a la ayuda de la aplicacion, ir a la opcién “Help = Help topics = User’s Guide ...".

& xeyTool IUI

File Wiew Tools ﬂelpl

Helptopics »| (B User's Guide ..

@ About »| %2 Help on active window's task
' U= m

|

Aparecera una ventana con dos paneles, a la izquierda los puntos de la ayuda y a la derecha el panel
donde se muestra la explicacion de cada punto:

Se puede acceder también mediante el bot6én de la barra de herramientas:
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[ User's Guide
[ fielcarme to ieyTool 1UI
™) sbout ..
& [ Tasks
o= [ Create
o= [ Archive files
o= [ Sign file
o= [ Verify signed file
o= [ Encrypt file
o= [ Decrypt file
o [ Import
o= 3 Export
o [ Supported farmats
™) support
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Welcome to KeyTool IUI

Copyright © 2001-2008 YellowCat Project. A Rights Reserved. All brands and their products are trademarks
| of their respective holders.

| Conditions of use

/| License Agreement

Please read the following terms and conditions before using this software. This software is the confidential
‘|and proprietary information of YellowCat Project. Your use of this software indicates your acceptance of this
license agreement and warranty.

| License
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